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Préambule 
 

 
 
 
La méthode de déploiement de Windows XP par rapport à Windows Seven a beaucoup évolué 
depuis l’apparition de ce dernier, et ceci pour deux raisons. D’une part à cause de la disparation de 
RIS au profit de WDS, et d’autres parts en raison de la mise à disposition de nombreux outils dont 
nous aurons l’occasion de reparler par la suite. 
 
Toutefois, l’outil le plus important utilisé tout au long de ce tuto est le WAIK. Il s’agit d’un logiciel 
permettant de personnaliser et d’automatiser le déploiement de Seven à l’aide d’un fichier XML. 
 
Pour ce tuto, vous aurez donc besoin :  

 D’une VM vierge pour y déployer Windows Seven Pro x64 

 De l’ISO de Windows Seven Pro x64 

 Eventuellement d’un serveur WDS  
 
 
 

 
 
 
  

http://www.scribd.com/michel_de/d/84967515-Installation-et-configuration-de-WDS-tuto-de-A-a-Z
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1. Windows Automated Installation Kit (WAIK) 
 
Le WAIK est un kit fournissant un ensemble de logiciels facilitant le déploiement de Windows Seven. 
Il regroupe les éléments suivants : 

 Windows System Image Manager (WSIM) 

 Volume Activation Management Tool (VAMT) 

 Application Compatibility Toolkit (ACT) 

 Microsoft Assessment and Planning toolkit (MAP) 

 Microsoft Deployment Toolkit (MDT) 
 
Attention, seuls les deux premiers outils sont inclus dans le WAIK. Pour les autres, il faudra vous les 
procurer à partir du site de Microsoft. 
 

1.1 Installation 
 
Pour commencer, télécharger le WAIK 3.0 à partir du lien suivant. Après avoir extrait son contenu, 
exécutez « StartCD » et cliquez sur Installation du Kit.  

 
1.2 Ajout du support du SP1 

 

Suite à la sortie du Service Pack 1 pour Windows Seven et Windows Server 2008 R2, une mise à jour 
pour le WAIK a été mise à disposition. Pour la télécharger, cliquez sur le lien suivant. L’installation 
de cette mise à jour diffère légèrement des installations classiques étant donné qu’il n’y a pas 
d’exécutable. Ouvrez alors une console CMD en tant qu’administrateur et exécutez les deux 
commandes suivantes : 
 
xcopy S:\ "C:\Program Files\Windows AIK\Tools\PETools" /ERUY 
 134 fichiers 

 
xcopy S:\*winpe-dot3svc* "C:\Program Files\Windows AIK\Tools\PETools" /ERY  
 82 fichiers 

 

Après quoi, le WAIK aura été mis à jour en version 3.1. 

http://www.microsoft.com/en-us/download/details.aspx?id=5753
http://www.microsoft.com/en-us/download/details.aspx?id=5188
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2. Préparation de l’environnement de travail 
 

2.1 Chargement d’un fichier catalogue 
 
Maintenant que le WAIK est installé, il est nécessaire de charger un fichier catalogue. Pour cela : 
 

 Ouvrez le gestionnaire WSIM (Windows System Image Manager) 

 Clic droit sur Sélectionnez une image […] > Sélectionnez l’image Windows 

 
 A partir du DVD/ISO de Windows 7 Pro, naviguez dans D:\sources 

 Sélectionnez le fichier install_Windows 7 PROFESSIONAL.clg 

 
Pour information, ce catalogue vous fournit un large panel d’options vous permettant de 

personnaliser et d’automatiser l’installation de Windows Seven. Le point 3 vous montrera comment 

ajouter et configurer ces options dans un fichier de réponse XML. 
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2.2 Création d’un fichier de réponses 
 
Nous allons donc maintenant créer un fichier de réponses qui contiendra l’ensemble des 

paramètres définis au point 3. Par ailleurs, l’utilisation de WDS supposera la création de 2 fichiers 

XML de réponses. Pour créer un fichier de réponses : 
 

 Clic droit sur Créer ou ouvrir un fichier de réponse > Nouveau 

 
 La liste suivante apparait alors avec les différentes étapes du processus d’installation : 
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3. Personnalisation d’un fichier de réponses 
 

3.1 Fichier de réponses pour WDS 
 

3.1.1 Ajout des composants au fichier de réponses 
 
Pour ajouter des composants à votre fichier de réponses, sélectionnez en un à partir de la liste ci-
dessous et faites un clic droit sur ce dernier > Ajouter le paramètre à la passe 1 windowsPE.  

 
Voici les composants à ajouter: 

 amd64_Microsoft-Windows-International-Core-WinPE\SetupUILanguage 

 amd64_Microsoft-Windows-Setup\DiskConfiguration\Disk\CreatePartitions\CreatePartition 

 amd64_Microsoft-Windows-Setup\DiskConfiguration\Disk\ModifyPartitions\ModifyPartition 

 amd64_Microsoft-Windows-Setup\WindowsDeploymentServices\ 

 
Après avoir ajouté ces composants, vous obtenez la liste suivante : 

 
Il est maintenant nécessaire de les configurer individuellement. 

 

3.1.2 Configuration des paramètres de langue 
 

 amd64_Microsoft-Windows-International-Core-WinPE 
 
Ce paramètre permet de configurer les paramètres de langue. Si vous souhaitez disposer d’une 
interface en français, remplissez les cases avec le paramètre « fr-FR » : 



8 
 

 
 amd64_Microsoft-Windows-International-Core-WinPE\SetupUILanguage 

 
3.1.3 Configuration des disques durs 

 
L’ensemble de ces paramètres permet de configurer et de créer des partitions sur un ou plusieurs 
disques. 

 

 amd64_Microsoft-Windows-Setup\DiskConfiguration\ 

 
 amd64_Microsoft-Windows-Setup\DiskConfiguration\Disk\ 
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 amd64_Microsoft-Windows-Setup\DiskConfiguration\Disk\CreatePartitions\CreatePartition 

 
 amd64_Microsoft-Windows-Setup\DiskConfiguration\Disk\ModifyPartitions\ModifyPartition 

 
3.1.4 Paramètres d’installation du système 

 
 amd64_Microsoft-Windows-Setup\WindowsDeploymentServices\ImageSelection\InstallTo 

 
Indiquez ici sur quel disque et partition sera installé le système d’exploitation : 
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3.1.5 Identifiants de connexion au serveur WDS 

 

 amd64_Microsoft-Windows-Setup\WindowsDeploymentServices\Login\Credential 

 
Attention ! L’utilisateur en question devra disposer de droits spécifiques. Pour cela, dirigez-vous au 

point 5.1.  

 

3.2 Fichier de réponses pour l’installation de Seven 
 
Nous allons maintenant créer un nouveau fichier de réponses de la même façon que celle décrite 

au point 2.2.  

 

3.2.1 Ajout des composants au fichier de réponses 
 
Pour ajouter des composants à votre fichier de réponses, sélectionnez en un à partir de la liste ci-
dessous et faites un clic droit sur ce dernier > Ajouter le paramètres à la passe X.  

 
Voici les composants à ajouter: 

 4 - amd64_Microsoft-Windows-Shell-Setup 

 4 - amd64_Microsoft-Windows-UnattendedJoin 

 7 - amd64_Microsoft-Windows-International-Core 

 7 - amd64_Microsoft-Windows-Shell-Setup\OOBE 

 7 - amd64_Microsoft-Windows-Shell-Setup\UserAccounts\LocalAccounts 
 
Après avoir ajouté ces composants, vous obtenez la liste suivante : 
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3.2.2 Nom Windows et profil par défaut 

 

 4 - amd64_Microsoft-Windows-Shell-Setup 
 

 ComputerName : L’étoile « * » indique que le nom sera attribué selon le paramètre 

Client naming policy définis au point 3.2.2 de mon tuto sur WDS. Si aucun serveur WDS 

n’est présent, le nom sera attribué aléatoirement 
 CopyProfile : indique que le profil à partir duquel a été exécuté la commande sysprep 

sera défini en tant que profil par défaut pour tous les nouveaux utilisateurs 

 
3.2.3 Identifiants de connexion au domaine 

 

 4 - amd64_Microsoft-Windows-UnattendedJoin\Identification 

http://www.scribd.com/michel_de/d/84967515-Installation-et-configuration-de-WDS-tuto-de-A-a-Z
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 DebugJoin : mettre à true pour « logger » cet évènement 
 JoinDomain : indiquez le domaine auquel sera joint l’ordinateur 
 MachineObjetctOU : indiquez l’OU où sera placé l’objet. Attention ce paramètre peut 

entrer en conflit avec le paramètre Computer Account Location définis au point 3.2.2 de 

mon tuto sur WDS 
 UnsecureJoin : mettre à false. Dans ce cas il sera nécessaire de remplir les identifiants au 

prochain point 

 
Pour en savoir plus concernant les différentes méthodes d’ajout au domaine, référez-vous ici. 
 

 4 - amd64_Microsoft-Windows-UnattendedJoin\Credentials 
 
Indiquez ici les identifiants d’un utilisateur disposant d’autorisations suffisantes pour ajouter des 
ordinateurs dans le domaine. Attention ! L’utilisateur en question devra disposer des droits 

indiqués au point 5.2.  

 
3.2.4 Ecran OOBE (Out Of Box Experience) 

 

 7 - amd64_Microsoft-Windows-International-Core 
 
Ce paramètre permet de configurer les paramètres de langue. Si vous souhaitez disposer d’une 
interface en français, remplissez les cases avec le paramètre « fr-FR » : 

http://www.scribd.com/michel_de/d/84967515-Installation-et-configuration-de-WDS-tuto-de-A-a-Z
http://technet.microsoft.com/en-us/library/cc730845%28WS.10%29.aspx
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 7 - amd64_Microsoft-Windows-Shell-Setup\ 

 
Indiquez la zone horaire dans laquelle vous vous situez. A titre d’information, vous trouverez 
l’ensemble des noms de zone dans la ruche du registre suivante :  
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Time Zones\ 

 
 7 - amd64_Microsoft-Windows-Shell-Setup\OOBE 

 
 HideEULAPage : masque la page d’acceptation des clauses du contrat Microsoft 
 HideWirelessSetupInOOBE : masque l’assistant de connexion au réseau 
 NetworkLocation : indique que l’emplacement du réseau est « travail » 
 ProtectYourPC :  

o Option 3 (recommandée) : les mises à jour sont désactivées. A utiliser si vous 
disposez d’une infrastructure WSUS 

o Option 2 : seules les mises à jour importantes sont installées 
o Option 1 : niveau de protection recommandé  
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 7 - amd64_Microsoft-Windows-Shell-Setup\UserAccounts\LocalAccounts\LocalAccount\ 

 
Indiquez ici les utilisateurs à créer et/ou à supprimer. En règle générale, il convient de créer un 
compte administrateur local et de supprimer le compte ayant servi de modèle pour la création du 
profil par défaut. 

 
 7 - amd64_Microsoft-Windows-Shell-Setup\UserAccounts\LocalAccounts\LocalAccount\Password 

 
Renseignez ici le mot de passe de l’utilisateur créé : 
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4. Appel du fichier de réponses 
 

4.1 A partir d’un serveur WDS 
 
Si vous souhaitez déployer vos images à l’aide d’un serveur WDS (ce qui est idéal), il convient 
d’intégrer à ce dernier les deux fichiers de réponses XML créés auparavant. Pour cela, veuillez 
suivre les instructions des deux points suivants : 
 

4.1.1 Fichier de réponses WDS 
 

Veuillez suivre la procédure du point 3.2.4 (aparté « Unattend file ») de mon tuto sur WDS pour 

appeler le fichier de réponse WDSunattend.xml. 
 

4.1.2 Fichier de réponses pour l’installation de Seven 
 

Veuillez suivre la procédure du point 7.4 de de mon tuto sur WDS pour appeler votre fichier de 

réponses SEVENunattend.xml au sein d’une image à déployer. 
 

4.2 A partir d’un SYSPREP local 
 
Si vous ne disposez pas d’une infrastructure WDS et que vous souhaitez utiliser des outils plus 
traditionnels tels que Symantec Ghost 15 (anciennement Norton Ghost) ou CloneZilla, vous devrez 
exécuter la commande suivante directement depuis l’image. Pour plus d’informations concernant le 

SYSPREP, référez-vous au point 7.2.1 de mon tuto sur WDS. Voici la commande à exécuter : 

 Ouvrez une console CMD en tant qu’administrateur 

 Placez-vous dans le répertoire C:\Windows\System32\sysprep 

 Exécutez la commande suivante : 
sysprep.exe /oobe /reboot /generalize /unattend:c:\SEVENunattend.xml 
 

 

  

http://www.scribd.com/michel_de/d/84967515-Installation-et-configuration-de-WDS-tuto-de-A-a-Z
http://www.scribd.com/michel_de/d/84967515-Installation-et-configuration-de-WDS-tuto-de-A-a-Z
http://clonezilla.org/
http://www.scribd.com/michel_de/d/84967515-Installation-et-configuration-de-WDS-tuto-de-A-a-Z
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5. Attribution des droits utilisateurs 
 

5.1 Connexion au serveur WDS 
 
Vous trouverez ici la liste des autorisations nécessaires pour chacune des étapes de déploiement 
d’une image via un serveur WDS.  
 

5.2 Connexion et intégration au domaine 
 
Le compte que vous allez utiliser pour ajouter des ordinateurs dans le domaine doit faire l’objet 
d’un choix important. En effet, il ne faut surtout pas utiliser un compte administrateur. D’une part 
car le mot de passe risque de changer fréquemment, et d’autre part car le compte pourrait être 
utilisé à des fins malveillantes si son mot de passe est révélé. Deux méthodes sont alors utilisables, 
la première ci-après étant plus que recommandée. Dans tous les cas, et pour commencer : 
 

5.2.1 Préparation de l’environnement 
 

 Créez un groupe de sécurité nommé : GS_add_computers-domain 

 Créez ensuite un utilisateur nommé : WAIK_user 

 Ajoutez cet utilisateur dans le groupe précédemment créé 
 

5.2.2 Modification de la limitation d’ajout d’ordinateurs dans le domaine 
 
Il faut savoir qu’il existe une limitation d’ajout d’ordinateurs dans le domaine, par utilisateur et sans 
limite de temps. Par défaut celle-ci est établie à 10, mais il est convenable de l’augmenter selon le 
nombre d’ordinateurs. Pour cela : 

 Ouvrez la console Adsiedit.msc 

 Clic droit sur ADSI Edit > Connect to > OK 

 
 Double-cliquez sur Default naming context 

 Clic droit sur DC=domaine,DC=com > Properties 

 Recherchez la valeur ms-DS-MachineAccountQuota  

http://technet.microsoft.com/fr-fr/library/cc754005%28v=ws.10%29.aspx
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 Modifiez la valeur avec le nombre de votre choix. L’effet est immédiat 

 

Attention ! Même les comptes et/ou groupes ajoutés dans la GPO du point 5.2.3 sont concernés 

par cette limitation. Pour information, voici le message qui est retourné lorsque ce seuil est atteint : 

 
 Pour réinitialiser cette limite, changez tout simplement sa valeur. 
 

5.2.3 Modification des comptes autorisés à ajouter des ordinateurs 
 
Maintenant que la limitation est augmentée, nous allons modifier la GPO qui définit les groupes 
ayant le droit d’ajouter des ordinateurs dans le domaine. Pour cela, il est nécessaire de modifier la 
GPO « Default Domain Controllers Policy » qui par défaut autorise tous les utilisateurs du groupe 
« Authenticated Users » à ajouter des ordinateurs dans le domaine : 
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Hors, il convient pour des raisons de sécurité de n’autoriser que le groupe « Administrators » et le 
groupe GS_add_computers-domain. Pour cela : 

 Modifiez la GPO « Default Domain Controllers Policy » : 
o Computer Configuration / Policies / Windows Settings / Security Settings / Local policies / 

User rights assignement => Add workstations to domain 

 Cliquez ensuite sur Add user or group et ajoutez le groupe Administrators ainsi que le 
groupe GS_add_computers-domain 

 
 Pour terminer, exécutez la commande gpdupdate /force 

 
Pour information, les ordinateurs créés via cette méthode auront pour propriétaire le groupe 
« Domain Admins », ce qui est tout à fait correct. 

 
5.2.4 Solution alternative via modification de droits sur l’UO 

 
Cette méthode consiste à attribuer des droits d’écriture sur l’UO où seront créés les ordinateurs. 
Pour cela : 

 Afficher les options avancées dans la console Active Directory : View > Advanced Features 
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 Clic droit sur l’UO en question > Properties > Security 

 
 Cliquez sur Advanced > Add > GS_add_computers-domain 

 Sélectionnez les attributs Create Computer et Delete Computer 

 
 Cliquez trois foix sur OK 

 
Attention ! Les ordinateurs créés via cette méthode auront pour propriétaire leur créateur, 
autrement dit le compte « WDS_user » ! Cette méthode n’est donc pas recommandée. 
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6. Divers 
 

6.1 Logs SYSPREP 
 
Si vous rencontrez des erreurs suite à un SYSPREP durant la phase de démarrage, sachez que 
l’ensemble des logs se trouvent dans ce fichier : 
C:\Windows\panther\unattendGC\setupact.txt 
 

6.2 Notes diverses 
 
Si aucun utilisateur n’est indiqué dans le paramètre UserAccounts, la création d’un utilisateur vous 
sera exigée : 
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Conclusion 
 
 
Il est à noter que Microsoft s’est beaucoup investi dans cette initiative. Par ailleurs, le 
développement de nombreux outils depuis l’apparition de Windows Vista a grandement simplifié 
les déploiements. Notez toutefois que la meilleure méthode permettant de déployer Seven est, de 
mon point de vue, WDS. C’est pourquoi je vous invite à lire mon article concernant la mise en place 
de ce serveur d’image ici. 
 
 
 
 

N’hésitez pas m’envoyer vos commentaires ou retours à l’adresse suivante : 
m.decrevoisier A-R-0-B-A-5 outlook . com 

 
 
 

Soyez-en d’ores et déjà remercié 
 
 

http://www.scribd.com/michel_de/d/84967515-Installation-et-configuration-de-WDS-tuto-de-A-a-Z
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